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SPECIAL NOTICES
• The software and this Installation Guide are exclusive copyrights of Yamaha Corporation.

• Use of the software and this guide is governed by the SOFTWARE LICENSING AGREEMENT which the purchaser fully agrees to upon 
breaking the seal of the software packaging. (Please read carefully the AGREEMENT at the end of this guide before installing the application.)

• Copying of the software or reproduction of this guide in whole or in part by any means is expressly forbidden without the written consent of the 
manufacturer.

• Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be held responsible for the 
results of the use of this guide and the software.

• Copying of the commercially available music data is strictly prohibited except for your personal use.

• The company names and product names in this Installation Guide are the trademarks or registered trademarks of their respective companies.

• Future upgrades of application and system software and any changes in specifications and functions will be announced separately.
Fr
a
n
ça

is
BESONDERE HINWEISE
• Dieses Programm und diese Installationsanleitung sind im Sinne des Urheberrechts alleiniges Eigentum der Yamaha Corporation.

• Die Benutzung des Programms und dieser Anleitung unterliegt der SOFTWARE-LIZENZVEREINBARUNG, mit der sich der Erwerber durch 
Öffnen des Siegels der Programmverpackung uneingeschränkt einverstanden erklärt. (Bitte lesen Sie die VEREINBARUNG am Ende dieser 
Anleitung vor Installation der Anwendung sorgfältig durch.)

• Das Kopieren der Software und die Reproduktion dieser Anleitung, in welcher Form auch immer, in Teilen oder als Ganzes, sind nur mit 
schriftlicher Genehmigung des Herstellers erlaubt und sonst ausdrücklich verboten.

• Yamaha leistet keinerlei Garantie hinsichtlich der Benutzung des Programms und der zugehörigen Dokumentation und übernimmt keine 
Verantwortung für die Ergebnisse der Benutzung dieser Anleitung oder des Programms.

• Das Kopieren im Handel erhältlicher Musikdaten ist nur für Ihren Privatgebrauch zulässig und sonst streng untersagt.

• Die in dieser Installationsanleitung erwähnten Firmen- und Produktnamen sind Warenzeichen bzw. eingetragene Warenzeichen der betreffenden 
Firmen.

• Zukünftige Aktualisierungen von Anwendungs- und Systemsoftware sowie jede Änderung der technischen Daten und Funktionen werden 
separat bekanntgegeben.
REMARQUES PARTICULIERES
• Les droits d’auteurs (copyright) de ce logiciel et de ce manuel d’installation appartiennent exclusivement à Yamaha Corporation.

• L’usage de ce logiciel et de ce manuel est défini par l’accord de licence auquel l’acheteur déclare souscrire sans réserve lorsqu’il ouvre le sceau 
de l’emballage du logiciel. (Veuillez donc lire attentivement l’accord de licence du logiciel situé à la fin de ce manuel avant d’installer le 
logiciel.)

• Toute copie du logiciel et toute reproduction totale ou partielle de ce manuel, par quel moyen que ce soit, est expressément interdite sans 
l’autorisation écrite du fabricant.

• Yamaha n’offre aucune garantie en ce qui concerne l’utilisation du logiciel et de la documentation. Yamaha ne peut en aucun cas être tenu 
responsable des dommages éventuels résultant de l’utilisation de ce manuel et de ce logiciel.

• Toute copie de données musicales commercialisées est formellement interdite, sauf pour usage personnel.

• Les noms des firmes et des produits apparaissant dans ce manuel d’installation sont des marques commerciales ou des marques déposées 
appartenant à leurs détenteurs respectifs.

• Les remises à jour du programme et du système ainsi que toute modification des caractéristiques et fonctions seront annoncées séparément.

To The Readers
Please note that the illustrations, colors and fonts may not be displayed properly depending on the system of the PC you use. Also, note that the page numbers on the thumbnails may not correspond to those on the document.
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Important Notices about the CD-ROM
Data Types
This CD-ROM includes two types of data: application software and sampled audio data. Please refer to pages 3 (Windows) and 9 (Macintosh) for software 
installation instructions. 
These applications allow you to edit MOTIF-RACK data and transfer data between your computer and the MOTIF-RACK.
You can play back the audio data from an audio CD player (or any CD playing/ripping function on your computer). 
The application software is contained on track 1 (as recognized on an audio CD player), and the sampled audio data is contained in the subsequent tracks.
Tracks 2 - 12 contain the demo songs created on the MOTIF-RACK or on another platform device using the Modular Synthesis Plug-in Boards. You can 
check out the Plug-in Board voices by playing back these tracks.

Never attempt to play back track 1 (containing the application software) on an audio CD player. Doing so may result in damage to your hearing as well 
as to your CD player/audio speakers. 

Operating System (OS)
The applications in this CD-ROM are provided in versions for both Windows and Macintosh operating systems. The installation procedure and the 
applications themselves differ depending on the operating system that you are using. Please refer to the appropriate installation instructions. 

For Windows, see page 3, 12.
For Macintosh, see page 9.

CD-ROM Installation Procedure
Before breaking the seal of the software packaging, please read carefully the Software Licensing Agreement at the end of this guide.

1 Verify that your system meets the operating requirements of the software (Voice Editor, Plug-in Board Editors, driver, etc.).
................................................................................................................................................................................................. Windows: page 4; Macintosh: page 9

2 Install the appropriate driver to your computer, and make the necessary settings.  ................................................................. Windows: page 5; Macintosh: page 10

3 Install the software (Voice Editor, etc.).  .................................................................................................................................. Windows: page 7; Macintosh: page 11

4 Start up the software.

For subsequent operations, refer to the owner’s manual for each software program (online help/PDF manual).

n  In order to view PDF files, you will need to install Acrobat Reader in your computer (Windows: page 5; Macintosh page: 10).

Quick solutions 
• Changing the MIDI port settings of the USB Driver ................ page 12
• The driver cannot be installed ................................................... page 13
• Playback response is not correct ............................................... page 13
• How can I delete or re-install the driver?.................................. page 13

Track 1 Application software; do NOT attempt to play back this track.

Track 2 Demonstration song recorded on the PLG150-DR.

Track 3 Demonstration song recorded on the PLG150-PC.

Track 4, 5 Demonstration songs recorded on the PLG150-PF.

Track 6, 7 Demonstration songs recorded on the PLG150-VL.

Track 8-10 Demonstration songs recorded on the PLG150-AN.

Track 11 Demonstration song recorded on the PLG150-DX.

Track 12 Demonstration song recorded on the PLG100-XG.
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For Windows Users
Contents of the CD-ROM
The CD-ROM contains a variety of applications (with installers) and data in the following folders.

*1 These applications are supplied with online/PDF manuals.
*2 Unfortunately, Yamaha makes no guarantee concerning the stability of these programs nor can it offer user support for them.

The applications in the “OPTPlug_” folder can be used as either stand-alone applications or as plug-in software within an Open Plug-in Technology (OPT) 
compatible program. 
The XG Editor can only be used as plug-in software within the SQ01.

About Open Plug-in Technology
You can start the Voice Editor for MOTIF-RACK or the File Utility software as either a stand-alone software or a plug-in application in the Open Plug-in 
Technology compatible application. Open Plug-in Technology (OPT) is a newly developed software format that allows control over MIDI devices from a 
music software sequencer.  For example, this allows you to start up and operate various parts of your music system, such as plug-in board editors, and 
mixing control editors – directly from an OPT-compatible sequencer, without having to use each separately.  This also makes it unnecessary to set MIDI 
drivers for each application, streamlining your music production system and making all operations more convenient and seamless.

About the OPT Levels
The client application and its compatibility with OPT is divided into three levels, as shown below.

Level 1 – OPT Panels provides basic support for opening and displaying OPT control panels that can transmit data via the clients’ external MIDI ports. 
Typically this will allow basic hardware editor control panels to operate properly.

Level 2 – OPT Processors provides support for real-time MIDI processors and panel automation. Typically this will allow both real-time and offline MIDI 
effects (e.g. Arpeggiators, transposers etc.) to operate properly and supply automation to OPT panels. 

Level 3 – OPT Views provides support for edit views and MIDI processors/panels that require direct access to client sequencer storage structures. Typically 
this will allow sophisticated MIDI edit views to be supported (e.g. List editors, Auto Accompaniment, Data Checkers etc.).

Folder Name Application Name Contents

Acroread_ Acrobat Reader*1*2 Enables you to view each PDF manual for the applications.

SQ01_ SQ01*1 Full-scale sequencing software, for easily creating and playing back your own songs on 
computer.

OPTPlug_ VEMRack_ Voice Editor for MOTIF-RACK*1 Enables you to edit the MOTIF-RACK voices on your computer.

VLV_ VL Visual Editor*1 Enables you to edit the Plug-in Board voices on your computer.  Even if you don’t have any 
Plug-in Boards, you can install these editors and at least view all the comprehensive parameters 
available and the easy-to-use, intuitive ways of editing them.ANEX_ AN Expert Editor*1

DXS_ DX Simulator*1

DR_ Plug-in Board Editor for PLG150-DR*1

PC_ Plug-in Board Editor for PLG150-PC*1

Plug_ XGE_ XG Editor*1

USBdrv_ YAMAHA USB MIDI driver (for Win98/Me) Enables your computer to communicate with the MOTIF-RACK when your computer and the 
MOTIF-RACK are connected using a USB cable.

USBdrv2K_ YAMAHA USB MIDI driver (for Win2000/XP)

DemoSong MOTIF-RACK Demo Songs Demo songs for the SQ01 when using the MOTIF-RACK as a tone generator.
3
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OPT Level Implementation for the Voice Editor
This chart shows the OPT compatibility of the Voice Editor for MOTIF-RACK.

n Certain operations may not work as expected if there is no corresponding function in the client application (sequencer, etc.).  The highest level of 
implementation for the client application is indicated in the OPT logo (which appears along with the version information in the application).

For information on the OPT compatibility of the other editors, refer to the on-line manual of each software.

Minimum System Requirements
The system requirements below may differ slightly depending on the particular operating system.

• SQ01
OS: Windows 98/Me/2000/XP Home Edition/XP Professional
Computer: 450 MHz or higher; Intel Pentium/Celeron processor
Available Memory: 64 MB or more (128 MB or more is recommended)
Hard Disk: 300 MB or more
Display: 800 x 600, High Color (16 bit)

• Voice Editor for MOTIF-RACK
OS: Windows 98/Me/2000/XP Home Edition/XP Professional
Computer: 166 MHz or higher; Intel Pentium/Celeron processor
Available Memory: 32 MB or more
Hard Disk: 16 MB or more
Display: 640 x 480, High Color (16 bit)

• Plug-in Board Editors
OS: Windows 98/Me/2000/XP Home Edition/XP Professional
Computer: 166 MHz or higher; Intel Pentium/Celeron processor
Available Memory: 32 MB or more
Hard Disk: 12 MB or more
Display: 800 x 600, High Color (16 bit) 

When using the VL Visual Editor, 1024 x 768 or more.

• USB MIDI Driver 
OS: Windows 98/Me/2000/XP Home Edition/XP Professional
Computer: 166 MHz or higher; Intel Pentium/Celeron processor
Available Memory: 32 MB or more (64 MB or more is recommended)
Hard Disk: 2 MB or more

OPT levels of the client application
Voice Editor for MOTIF-RACK operation

Operation support Operation limits

VIEWS (Level3)              Yes None

PROCESSORS (Level2)  Yes None

PANELS (Level1)          Yes (with limitations) Bulk reception
4



              

     

            

En
g
lis

h

Software Installation

Uninstall (removing the installed 
application)
You can remove the installed application software. 
Select [START] (→ [Settings]) → [Control Panel] → [Add/Remove 
Programs] → [Install/Uninstall], then select the application to be 
removed and click [Add/Remove...]. 
Follow the on-screen instructions to uninstall the application.

n The button names or menus may differ depending on the computer OS.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Acrobat Reader

In order to view the electronic (PDF) manuals included with each application, 
you’ll need to install Acrobat Reader.

n If an older version of Acrobat Reader is installed on your PC, you’ll need 
to uninstall it before proceeding.

1 Double-click on the “Acroread_” folder. 
Four different language folders will be displayed.

2 Select the language you want to use and double-click on its folder. 
The file “arxxx***.exe” file will be displayed. (“xxx” indicates figures and 
“***” indicates the selected language; e.g., “ar500enu.exe”.)

3 Double-click on “arxxx***.exe.”
Acrobat Reader Setup Dialog box will be displayed.

4 Execute the installation by following the on-screen directions.

After installation is complete, the Acrobat folder appears on your PC (in 
Program Files, as the default).
For information on using the Acrobat Reader, refer to the Reader Guide in the 
Help menu.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
USB MIDI Driver

To operate the MOTIF-RACK from your computer via USB, you’ll need to 
install the appropriate driver software.
The USB-MIDI driver is software that transfers MIDI data back and forth 
between sequence software and the MOTIF-RACK via a USB cable.

Windows 98/Me users → See below.
Windows 2000/XP users → See page 6.

Computer

MOTIF-RACK

USB cable

Driver

Sequence
Software
5

   

   

● Installing the driver on a Windows 98/
Me system

1 Start the computer.

2 Insert the included CD-ROM into the CD-ROM drive.

3 Make sure the POWER switch on the MOTIF-RACK is set to OFF and 
use the USB cable to connect the USB terminal of the computer (or the 
USB hub) to the USB terminal of the MOTIF-RACK. When the MOTIF-
RACK is turned on, the computer automatically displays the “Add New 
Hardware Wizard.” If the Add New Hardware Wizard does not appear, 
click “Add New Hardware” in the Control Panel.

n For Windows Me users, check the radio button to the left of 
“Automatic search for a better driver (Recommended)” and click 
[Next]. The system automatically starts searching and installing the 
driver. Proceed to Step 8. If the system does not detect the driver, 
select “Specify the location of the driver (Advanced)” and specify 
the CD-ROM drive’s “USBdrv_” folder to install the driver. 

4 Click [Next]. 
The window below enables you to select the search method.

Windows 98

Windows Me
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5 Check the radio button to the left of “Search for the best driver for your 
device. (Recommended).” Click [Next]. The window below enables you to 
select a location in which to install the driver.

6 Check the “CD-ROM drive” box and uncheck all other items. Click [Next].

n The system may ask you to insert a Windows CD-ROM while it 
checks for the driver. Specify the USBdrv_ directory of the CD-ROM 
drive (such as D:\USBdrv_\) and continue the installation.

n When using the Windows 98, specify the USBdrv_ directory of the 
CD-ROM drive (such as D:\USBdrv_\) and continue the installation.

7 When the system detects the driver on the CD-ROM and is ready for 
installation, it displays the following screen. 
Make sure that the “YAMAHA USB MIDI Driver” is listed, and click 
[Next]. The system starts the installation.
6

8 When the installation is complete, the following screen appears. Click 
[Finish].

n Some computers may take about ten seconds or more to show this 
screen after the installation is complete.

The driver has been installed.

● Installing the driver on a Windows 2000 
system

1 Start the computer and use the “Administrator” account to log into Windows 
2000.

2 Select [My Computer | Control Panel | System | Hardware | Driver Signing | 
File Signature Verification], and check the radio button to the left of “Ignore -
Install all files, regardless of file signature” and click [OK].

3 Insert the included CD-ROM into the CD-ROM drive.

4 Make sure the POWER switch on the MOTIF-RACK is set to OFF and use 
the USB cable to connect the USB terminal of the computer (or the USB 
hub) to the USB terminal of the MOTIF-RACK. When the MOTIF-RACK 
is turned on, the computer automatically displays the “Found New 
Hardware Wizard.” Click [Next].

5 Check the radio button to the left of “Search for a suitable driver for my 
device. (Recommended).” Click [Next].
The window that appears enables you to select a location in which to install 
the driver.

6 Check the “CD-ROM drives” box and uncheck all other items. Click [Next].

n The system may ask you to insert a Windows CD-ROM while it 
checks for the driver. Specify the “USBdrv2k_” directory of the CD-
ROM drive (such as D:\USBdrv2k_\) and continue the installation.

7 When the installation is complete, the system displays “Completing the 
Found New Hardware Wizard.” Click [Finish].

n Some computers may take about ten seconds or more to show this 
screen after the installation is complete. 

8 Restart the computer. The driver has been installed.

Windows 98

Windows Me
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● Installing the driver on a Windows XP 
system

1 Start the computer.

2 Select [Start] → [Control Panel]. If the control panel appears as shown 
below, click “Switch to Classic View” in the upper left of the window.
All control panels and icons will be displayed.

3 Go to [System] → [Hardware] → [Driver Signing] → [File Signature 
Verification], and check the radio button to the left of “Ignore -Install all 
files, regardless of file signature” and click [OK].

4 Click the [OK] button to close System Properties, and then click “X” in the 
upper right of the window to close the Control Panel.

5 Insert the included CD-ROM into the CD-ROM drive.

6 Make sure the POWER switch on the MOTIF-RACK is set to OFF and use 
the USB cable to connect the USB terminal of the computer (or the USB 
hub) to the USB terminal of the MOTIF-RACK. When the MOTIF-RACK 
is turned on, the computer automatically displays the “Found New 
Hardware Wizard.”

7 Check the radio button to the left of “Search for a suitable driver for my 
device. (Recommended).” Click [Next]. The system starts the installation.

8 When the installation is complete, the system displays “Completing the 
Found New Hardware Wizard.” Click [Finish].

n Some computers may take about ten seconds or more to show this 
screen after the installation is complete.

9 Restart the computer. The driver has been installed.

● SQ01
In addition to its sequencer function, the SQ01 can also be used for voice editing 
once the Plug-in application “Voice Editor for MOTIF-RACK” is installed.

1 Double-click on the “SQ01_” folder. Various files including “setup.exe” 
will be displayed.

2 Double-click on “Setup.exe.”
SQ01 Setup Dialog box will be displayed.

3 Execute the installation by following the directions appearing on the screen.
After the installation, select “Restart”.
After restarting Windows, you will find the YAMAHA folder on your PC 
(Program Files as the default) and SQ01 folder in the YAMAHA folder.  
Refer to the online manuals for instructions on how to use the application.
7

SQ01 MIDI Setup

1 Start SQ01.
Choose [Programs] from the [Start] menu, then select 
[YAMAHA SQ01] → [SQ01]. 

2 From the [Setup] menu (Track View window), select [MIDI] → 
[Device], to call up the “Device” page of the “MIDI” dialog.

3 Select the appropriate output port (for example, “YAMAHA USB 
OUT 0-1”) in the [OUT] box, to use the USB connection with the 
MOTIF-RACK.

4 Select the appropriate input port (for example, “YAMAHA USB 
IN 0-1”) in the [IN] box, then click [OK] to close the dialog box.

n You can select the audio driver and the audio in/out device if 
necessary. From the [Setup] menu, select [Audio] → [Device] to 
call up the “Device” page of the “Audio” dialog.

n The USB connection to the MOTIF-RACK can only be used for 
transfer of MIDI data. No audio data can be transferred via USB. 

● Voice Editor, Editors for Plug-in Boards

You can use edit the voices of the MOIF-RACK, and Plug-in Boards.

1 Double-click on the “OPTPlug_” or “Plug_” folder.
Some folders will be displayed (page 3).

2 Double-click the desired folder.
Various files including “Setup.exe” will be displayed. 

3 Double-click on “Setup.exe.”
The Software Setup Dialog box will be displayed.

4 Execute the installation by following the directions appearing on the screen. 
After completing the installation procedure, you can find the each software in 
the designated folder and find that each application is added to the [Plug-in]/
[View] menu on the SQ01. Refer to the online help/PDF manuals for 
instructions on how to use the application.
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MIDI port setting
(when starting the software 
as a stand-alone application)
Before setting the MIDI port on the Voice Editor or other editors, you should set 
the MIDI port from the MIDI SETUP toolbar. 

n When you start the editor as a plug-in application in the Open Plug-in 
Technology compatible application, refer to the PDF manual for the 
respective software.

1 Start the editor. 

2 Click the MIDI Setup button in the Toolbar. 

3 In the MIDI Setup window called up via step #2, select the appropriate 
device from the [IN]/[OUT] box to use the MOTIF-RACK connected to the 
USB terminal (For example, select “YAMAHA USB IN 0-1” and 
“YAMAHA USB OUT 0-1”).

n In order for MIDI ports to be available here, you’ll need to select the 
relevant MIDI port within each application software. This is the port that 
you’ll use in the various software. For details on setting the MIDI port, 
refer to the on-line manual of each software. 

MIDI Setup button
8

Demo Song Playback with the included 
Sequence Software

● Files

Files in the “DemoSong” folder are the demo song data for the included 
sequence software. You can play back the demo songs as follows.

n For details about the software, refer to the on-line help included 
in the software.

n Some of the demo songs provided here may the same as those 
included on your instrument.  (Depending on the particular 
instrument, all songs here may be the same as the songs on your 
instrument.)  At the very least, you can use the demo songs to try 
out and confirm the operations and functions of the sequence 
software.

●  Procedure

1 Verify that your system meets the operating requirements of the 
software (page 4).

2 Connect your instrument to your computer.  (Refer to the 
owner’s manual for details on connections.)

3 Install the appropriate driver for your computer, and make the 
necessary settings (page 5).

4 Install the sequence software (page 7).

5 Start up the software, then make the necessary MIDI settings  
(page 7).

6 Copy the demo song file(s) in the CD-ROM to the hard disk.

7 From the [File] menu, select [Open] to call up the “Open” dialog 
box.  Select the demo song copied to hard disk from the box, 
then click the [Open] button.  The New Track View Window 
(refer to the software’s on-line help) will be shown. 

8 Click the play button of the Transport Bar (refer to the software’s 
on-line help) to start the demo song playback.

For other operations, refer to the sequence software’s on-line help.
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For Macintosh Users

Contents of the CD-ROM
The CD-ROM includes two folders: “International” and “Japanese.” Double-click on the “International” folder to open it. A variety of applications (with installers) 
and data are contained in the following folders.

*1 These applications are supplied with online/PDF manuals.
*2 Unfortunately, Yamaha makes no guarantee concerning the stability of these programs nor can it offer user support for them.

Minimum System Requirements
The system requirements below may differ slightly depending on the particular operating system.

• Voice Editor for MOTIF-RACK
OS: Mac OS 8.6 through Mac OS 9.22 (The Mac OS X and Mac Classic environments are not supported)
Computer: A Macintosh computer with a PowerPC or later CPU
Available Memory: 16 MB or more
Hard Disk: 32 MB or more
Display: 800 x 600, 32,000 colors or more

• Plug-in Board Editors
OS: Mac OS 8.0 through Mac OS 9.22 (The Mac OS X and Mac Classic environments are not supported)

When using the Plug-in Board Editor for PLG150-DR/PLG150-PC, Mac OS 8.6 through Mac OS 9.22 
(The Mac OS X and Mac Classic environments are not supported)

Computer: A Macintosh computer with a PowerPC or later CPU 
Available Memory: • DX Simulator/AN Expert Editor: 13MB or more

• VL Visual Editor: 5MB or more
• Plug-in Board Editor for PLG150-DR/PLG150-PC: 12MB or more

Hard Disk: • DX Simulator: 5.5MB or more
• AN Expert Editor: 7.5MB or more
• VL Visual Editor: 5MB or more
• Plug-in Board Editor for PLG150-DR/PLG150-PC: 16MB or more

Display: 800 x 600, 256 colors or more 
When using the VL Visual Editor, 640 x 480 or more

• USB MIDI Driver 
OS: Mac OS 8.5 through Mac OS 9.22 (The Mac OS X and Mac Classic environments are not supported)
Computer: A Macintosh computer with a USB connector and a PowerPC or later CPU
Memory: 64 MB or more (128 MB or more is recommended)
n Turn off virtual memory.

Hard disk: 2 MB or more
Other: OMS 2.3.8 (included in the CD-ROM in the package)

Folder Name Application Name Contents

Acroread_ Acrobat Reader*1*2 Enables you to view each PDF manual for the applications.

OMS_ Open Music System (OMS)*1 Enables you to use several MIDI applications on the Mac OS.

OMS Setup for YAMAHA Contains the OMS Setup files for Yamaha tone generators.

USBdrv_ YAMAHA USB MIDI driver Enables your computer to communicate with the MOTIF-RACK when your computer 
and the MOTIF-RACK are connected using a USB cable.

MRackEditor_ Voice Editor for MOTIF-RACK*1 Enables you to edit the MOTIF-RACK voices on your computer.

VLVEditor_ VL Visual Editor*1 Enables you to edit the Plug-in Boards voices on your computer. Even if you don’t have 
any Plug-in Boards, you can install these editors and at least view all the 
comprehensive parameters available and the easy-to-use, intuitive ways of editing 
them.

ANEXEditor_ AN Expert Editor*1

DXSim_ DX Simulator*1

DREditor_ Plug-in Board Editor for PLG150-DR*1

PCEditor_ Plug-in Board Editor for PLG150-PC*1
9
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Software Installation

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Acrobat Reader

In order to view the electronic (PDF) manuals included with each application, 
you’ll need to install Acrobat Reader. 

1 Double-click on the “Acroread_” folder.
Three different language folders will be displayed: English, German and 
French.

2 Select the language you want to use and double-click on its folder.
“Reader Installer” will be displayed.
The Installer name may differ depending on the language you select.

3 Double-click on the “Reader Installer.”
Acrobat Reader Setup Dialog will be displayed.

4 Execute the installation by following the directions appearing on the screen. 
After installation is complete, the Acrobat folder appears on your computer 
(in Hard Disk, as the default).
For information on using the Acrobat Reader, refer to the Reader Guide in 
the Help menu.

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Open Music System (OMS) 2.3.8

OMS allows you to use several MIDI applications on the Mac OS at the same time.

1 Double-click on the “OMS” folder (English version only).
“Install OMS 2.3.8” will be displayed.

2 Double-click on “Install OMS 2.3.8.”
OMS Setup Dialog will be displayed.

3 Execute the installation by following the on-screen directions. 
After the installation, select “Restart.”

n After the installation is complete, you may possibly encounter an 
error message warning that the installer did not close. In this case, go 
to the “File” menu and select “Quit” to close the installer. Then 
reboot the computer.

After restarting the Macintosh, you will find the “Opcode”/“OMS Applications” 
folder on your computer (Hard Disk, as the default).

4 Copy the “OMS_2.3_Mac.pdf” in the CD-ROM to the “OMS Applications” 
folder (drag-and-drop it to the folder).
Refer to the “OMS_2.3_Mac.pdf” (English version only) how to use the 
application.

5 Copy the “OMS Setup for YAMAHA” in the CD-ROM to the “OMS 
Applications” folder (drag-and-drop it to the folder).
In the “OMS Setup for YAMAHA” folder you will find the OMS Setup files 
for the Yamaha tone generators, which can be used as templates.
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USB MIDI Driver

To operate the MOTIF-RACK from your computer via USB, you’ll need to 
install the appropriate driver software.
The USB-MIDI driver is software that transfers MIDI data back and forth 
between sequence software and the MOTIF-RACK via a USB cable.

First install OMS before installing the USB-MIDI driver. Also, after installing 
the driver, you will need to set up OMS (above).

1 Start the computer.

2 Insert the included CD-ROM into the CD-ROM drive. The system displays 
the CD-ROM icon on the desktop.

3 Double-click the CD-ROM icon and double-click the “Install USB Driver” 
icon in the “USBdrv_” folder to display the following installation screen. 

4 The “Install Location” box displays the destination of the installation. If you 
wish to change the destination disk or folder, use the [Switch Disk] button 
and the pop-up menu to specify the desired destination.

n This box usually displays the start-up disk as the destination.

5 Click the [Install] button. The system displays the following message: “This 
installation requires your computer to restart after installing this software. 
Click Continue to automatically quit all other running applications.” Click 
[Continue].

n To cancel the installation, click [Cancel].

Computer

Sequence
Software

OMS Driver

USB cable

MOTIF-RACK
0
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6 The installation starts. If the driver has already been installed, the following 
message appears. To return to step 3, press [Continue]. To complete the 
installation, click [Quit].

7 When the installation is complete, the system displays the following 
message: “Installation was successful. You have installed software which 
requires you to restart your computer.” Click [Restart]. The computer 
automatically restarts. You can locate the installed files in the following 
locations:

• System Folder | Control Panels | YAMAHA USB MIDI Patch
• System Folder | Extensions | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS Driver

Voice Editor for MOTIF-RACK, Editors for 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • •
Plug-in Boards

You can edit the voices of the MOTIF-RACK and Plug-in Boards on your 
computer. 

1 Double-click on the desired folder (page 9). 
“Install ***” (“***” indicates the application name) will be displayed.

2 Double-click on “Install ***.”
The Software Setup Dialog will be displayed.

3 Execute the installation by following the on-screen directions. 
After installing, you will find the “YAMAHA Tools” folder on your 
computer (Hard Disk as the default). 
For details, refer to the on-line Help or the PDF owner’s manual.
1

  

Setting up OMS
The OMS studio setup file for the MOTIF-RACK is contained in the included 
CD-ROM. This studio setup file is used for setting up OMS. 

n Before performing the following procedure, the OMS and USB MIDI 
Driver should be installed. 

1 Use a USB cable to connect the USB terminal of the computer (or the USB 
hub) to the USB terminal of the MOTIF-RACK and turn the MOTIF-
RACK’s power on. 

2 Start the computer. 

3 Insert the included CD-ROM into the CD-ROM drive of your Macintosh 
computer. The CD-ROM icon appears on the desktop. 

4 Double-click on the CD-ROM icon, “International”, “OMS”, and “OMS 
Setup for YAMAHA.”
The “USB-MOTIF-RACK” file appears. Copy this to the hard disk on your 
computer. 

5 Double-click on the “USB-MOTIF-RACK” file to start the OMS Setup.  

n If you are connecting several MOTIF-RACKs to the computer, a USB 
hub is necessary.

6 After starting the OMS Setup, the Studio setup file double-clicked in step #5 
opens. 

n If “ ” is not indicated at the right of the setup file name, select 
“Make Current” from the “File” menu and execute the save operation. 

The OMS studio setup has been completed.

n After the OMS studio setup above has been completed, your 
computer will recognize only the MOTIF-RACK as a MIDI 
instrument. If you use another MIDI instrument in addition to the 
MOTIF-RACK or you add a second MOTIF-RACK to the existing 
system, you should create an original Studio Setup file. For details, 
refer to the on-line manual supplied with the OMS. 

n The included OMS studio setup file may not function even if you 
follow the above procedure, depending on your Macintosh/Mac OS 
version. (MIDI data cannot be transmitted/received even if the setup 
becomes available.) 
In this situation, connect your Macintosh to the MOTIF-RACK via 
the USB cable and follow the procedure below to re-create the setup 
file. 

1 Start OMS Setup and select “New Setup” from the “File” menu. 

2 The “OMS Driver Search” dialog appears. Remove the check from 
the “Modem” and “Printer” check boxes, and click [Search] to 
execute the device search. 
If the Search operation has been completed successfully, the [USB-
MIDI] device is displayed in the OMS driver setting dialog.

3 Click the [OK] button to search for ports. Port 1, Port 2 ... appears 
in the dialog. Mark the appropriate checkbox of the port and click 
the [OK] button to store the setting. 

Indicates this setup is available
1
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For Windows/
Macintosh Users

About the USB Driver Setup 
window
From this window, you can change the MIDI port number transmitted to the 
MOTIF-RACK from the one set in the computer sequence software. 
For Windows, select [START] (→ [Settings]) → [Control Panel] → [MIDI-USB 
Driver] to open the driver setup window.
For the Mac, select [Apple] menu → [Control Panels] → [YAMAHA USB 
MIDI Patch] to open the setup window. 

The default settings are as follows. 

* This is actually the MIDI port number set from the MIDI display in the Utility 
mode.

Port number MIDI OUT terminal 
(Thru Port number*)

MIDI IN terminal
(Track Port number)

1 MIDI OUT (1) MIDI IN (1)

2 MIDI OUT (2) -

3 MIDI OUT (3) -

4 MIDI OUT (4) -

5 MIDI OUT (5) -

6 MIDI OUT (6) -

7 MIDI OUT (7) -

8 MIDI OUT (8) -
1
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The driver cannot be installed.
• Is the USB cable connected correctly?

→ Check the USB cable connection. 
→ Disconnect the USB cable, then connect it again.

Windows
• Is the USB function enabled on your computer?

→ When you connect the MOTIF-RACK to the computer for the first time, if 
the “Add New Hardware Wizard” does not appear, the USB function on 
the computer may be disabled. Perform the following steps. 

1 Double-click “System” in the Control Panel to open the System 
Properties window.

2 Double-click the “Device Manager” tab and make sure that no “!” or 
“x” marks appear at “Universal serial bus controller” or “USB Root 
Hub.” If you see an “!” or “x” mark, the USB controller is disabled. For 
more information, refer to the owner’s manual of your computer.

Windows
• Is any unknown device registered?

→ If driver installation fails, the MOTIF-RACK will be marked as an 
“Unknown device,” and you will not be able to install the driver. Delete the 
“Unknown device” by following the steps below.

1 Double-click “System” in the Control Panel to open the System 
Properties window.

2 Double-click the “Device Manager” tab. With the “View devices by 
type” check box checked, look for “Other devices.”

3 If you find “Other devices,” double-click it to extend the tree to look 
for “Unknown device.” If one appears, select it and click the [Remove] 
button.

4 Remove the USB cable from the MOTIF-RACK, and make the 
connection again.

5 Install the driver again. 

When controlling the MOTIF-RACK from your 
computer via USB, the MOTIF-RACK does not 
operate correctly or no sound is heard.

• Did you install the driver?
• Is the USB cable connected correctly? 
• Are the volume settings of the tone generator, playback device, and 

application program set to the appropriate levels?
• Have you selected an appropriate port in the sequence software?
• Check whether the MIDI IN/OUT setting in the Utility mode corresponds to 

the terminal/cable actually used (USB or MIDI) (see MOTIF-RACK Owner’s 
Manual page 61).

Playback response is delayed.

• Does your computer satisfy the system requirements? 
• Is any other application or device driver running?

Macintosh 
→ Turn off virtual memory.
→ Disable AppleTalk.
1

Cannot suspend or resume the computer 
correctly.

• Do not suspend the computer while the MIDI application is running.
• If you are using Windows 2000, you may not be able to suspend/resume 

normally, depending on the particular environment (USB Host Controller, 
etc.). Even so, simply disconnecting and connecting the USB cable will allow 
you to use the MOTIF-RACK functions again.

How can I delete or re-install the driver?

Windows Me/98 
1 When the MOTIF-RACK is recognized correctly, double-click 

“System” in the Control Panel to open the System window.
2 Double-click the “Device Manager” tab, select “YAMAHA USB MIDI 

Driver” and delete it.
3 Use the MS-DOS prompt or Explorer to delete the following three 

files. 

n To delete the files below using Explorer, select “Folder Options” 
from the Tool (View) menu, and select “Show all files (and folders).”
• \WINDOWS\INF\OTHER\YAMAHAMOTIF-R.INF
• \WINDOWS\SYSTEM\Xgusb.drv
• \WINDOWS\SYSTEM\Ymidusb.sys

4 Disconnect the USB cable.
5 Restart the computer.
6 Re-install the driver. 

Macintosh
1 Delete the files in the following locations:

• System Folder | Control Panels | YAMAHA USB MIDI Patch
• System Folder | Extensions | USB YAMAHA MIDI Driver
• System Folder | OMS Folder | YAMAHA USB MIDI OMS Driver

2 Restart the computer.
3 Install the driver and set up OMS.

The demonstration song plays, but the 
voices sound wrong or unexpected.

Windows
• The demonstration song in the CD-ROM is designed for play back with the 

MOTIF-RACK’s default (factory set) settings.  For proper playback, execute 
the Factory Set operation (see MOTIF-RACK Owner’s Manual page 56). 
3
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SOFTWARE LICENSING AGREEMENT
The following is a legal agreement between you, the end user, and Yamaha Corporation (“Yamaha”). The enclosed Yamaha software program is 
licensed by Yamaha to the original purchaser for use only on the terms set forth herein. Please read this licensing agreement with care. Opening this 
package indicates that you accept all terms outlined herein. If you do not agree to the terms, return this package unopened to Yamaha for a full 
refund.

1. GRANT OF LICENSE AND COPYRIGHT

Yamaha grants you, the original purchaser, the right to use one copy of the enclosed software program and data (“SOFTWARE”) on a single-user 
computer system. You may not use it on more than one computer or computer terminal. The SOFTWARE is owned by Yamaha and is protected by 
Japanese copyright laws and all applicable international treaty provisions. You are entitled to claim ownership of the media in which the 
SOFTWARE is included. Therefore, you must treat the SOFTWARE like any other copyrighted materials.

2. RESTRICTIONS

The SOFTWARE program is copyrighted. You may not engage in reverse engineer-ing or reproduction of the SOFTWARE by other conceivable 
methods. You may not reproduce, modify, change, rent, lease, resell, or distribute the SOFTWARE in whole or in part, or create derivative works 
from the SOFTWARE. You may not transmit or network the SOFTWARE with other computers. You may transfer ownership of the SOFTWARE 
and the accompanying written materials on a permanent basis provided that you retain no copies and the recipient agrees to the terms of the 
licensing agreement.

3. TERMINATION

The licensing condition of the software program becomes effective on the day that you receive the SOFTWARE. If any one of the copyright laws or 
clauses of the licensing conditions is violated, the licensing agreement shall be terminated automatically without notice from Yamaha. In this case, 
you must destroy the licensed SOFTWARE and its copies immediately.

4. PRODUCT WARRANTY

Yamaha warrants to the original purchaser that if the SOFTWARE, when used in normal conditions, will not perform the functions described in the 
manual provided by Yamaha, the sole remedy will be that Yamaha will replace any media which proves defective in materials or workmanship on 
an exchange basis without charge. Except as expressly set forth above, the SOFTWARE is provided “as is,” and no other war-ranties, either 
expressed or implied, are made with respect to this software, including, without limitation the implied warranties of merchantability and fitness for 
a particular purpose.

5. LIMITED LIABILITY

Your sole remedies and Yamaha’s entire liability are as set forth above. In no event will Yamaha be liable to you or any other person for any 
damages, including without limitation any incidental or consequential damages, expenses, lost profits, lost savings or other damages arising out of 
the use or inability to use such SOFTWARE even if Yamaha or an authorized dealer has been advised of the possibility of such damages, or for any 
claim by any other party.

6. GENERAL

This license agreement shall be interpreted according to and governed by Japanese laws.
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